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Introduction

Welcome to Mastering Computer Basics in Windows OS! | want to start out by telling you why | believe
you’ve made the right choice by getting this book. In fact, | don’t just believe you’ve made the right
choice—I know it! Why? Because in this book, I'm going to go over the basic concepts of using Windows,
specifically Windows 10, as it is most recent version. I'll show you, with very simple steps and
screenshots, what you’re going to be seeing on your screen. | will also show you where you can find
each item and how to open it inside of Windows. By the time you’re done going through this book, you

will have acquired the basic skills to operate the Windows Operating System.

After reading this book, you will be able to do following:

e Know the parts of a computer (hardware components) and be able to identify them.
e Navigate within the Windows Operating System.
e Connect to a network.
e Use some common keyboard shortcuts. (I will also provide you links to more resources for
those.)
e Perform basic troubleshooting and potentially be able to fix about half the issues you may
encounter within the Windows Operating System.
Who am | to teach you these things? Let me tell you a little bit about myself. My name is David Levine,
and I'm the founder of ResTech Solutions. I've been working in IT for over ten years, and | have spent
time working as a frontline help desk technician. In doing that, I've probably seen just about all the crazy

stuff you can imagine with computers, so | can certainly tell you what you need to know and help you

get started at a basic level.

After working at the help desk level, | moved over to an applications support role where | was doing

more specialized support with specific applications, along with still doing the traditional support for
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Windows and general desktop use. | also do work on websites, specifically with WordPress. | think the
most important thing about me is | have a passion for helping others use technology, both with any
issues or problems they may face and how to do things with the technology. Because of that, | believe
this book is the perfect resource for you. It is crafted to ensure you have the skill set and the
fundamental knowledge you need to successfully use Windows in the everyday things you do at home,

work, school, or wherever.

| will say that this information is second nature to me, and | know that working in Windows or computer
technology in general is not instinctive for many people, but I'm here to help out. This book will not give
you overnight mastery of Windows skills, but it is for people who want to learn. Mastery requires

repetition, using these skills over and over. | guarantee if you go through the book and practice the skills

and learn where things are, you’ll be successful.

What I'm providing you is a step-by-step understanding and a guide to help you learn and master the
basics of using Windows. I'm going to keep the technology jargon to a minimum, though there will be
instances where | need to give technical words or acronyms to you, so you understand when they are
referenced later. And, yes, technology is always changing. But the basic skills and knowledge | teach in
this book are things that will always be useful, and learning them will build the foundation of your skill

set.

Now that you understand what you will be learning and why it is important, let’s get into our first topic:

computer hardware.
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Computer Hardware

What You See When You Sit Down at a Computer

Starting at the most basic level, let’s start off by talking about what you see when you sit down to use a
computer. There are two main parts you’ll notice: (1) the monitor or the screen and (2) the actual
computer (fig. 1). That’s true whether you have a traditional desktop, all-in-one device where everything

is integrated together, laptop, or mobile device. It’s all essentially the same.

Figure 1: Monitor & laptop

The monitor is what displays what you are doing on the screen. The monitor itself is not the computer.
The one exception to that is if you have an all-in-one computer. The piece of equipment is all in one, but
the monitor is still technically a separate component. The monitor displays the video output from the

computer it is hooked up to.
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The computer is the box that includes all of the components that make your computer system work.
There are several parts to a computer, and each has a different function. Many of these parts can be
likened to parts in the human body, so as | describe each part, | will compare it to the parts of the

human body, so you get a better understanding of the components.

Case

The computer case is essentially the shell of the computer (fig. 2). The computer case holds all the other

components of the computer inside. It is like the bones of the computer in that it provides the structure

for everything else.

Figure 2: Computer case with computer parts inside

Motherboard

The computer motherboard (fig. 3), sometimes referred to as the system board, is like the nervous

system of the computer because it connects all the parts together. If you ever look at a motherboard or
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system board, you might see what looks like wires etched onto the boards. Think of that as the nerves of
the human body, which transmit all the data or signals. Then, of course, the motherboard is how you
plug in all the peripherals to the computer, like a mouse, keyboard, etc. Again, it ties everything

together.

Figure 3: Motherboard

CPU or Processor

This the brains of the computer, so think of it like your brain (fig. 4). It processes all the commands that
are received or sent by the hardware and software, and it runs all the computations and processes.

Without a CPU, the system couldn’t process any information or function or send commands out.
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Figure 4: CPU

RAM

The RAM is the short-term memory of the computer. These are the little green sticks with little black
blocks on them that you’ve probably seen before. As you see in the photo here (fig. 5), there are a
whole bunch of different kinds of RAM. You can see here how they look and that they’re all similar.
Some memory or RAM modules may have a heat shield on them, so they may look a little different, but

they’re all pretty much the same.
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Figure 5: RAM

Again, think of RAM as short-term memory because any data on it is only temporary, as it only stores
data when it has power. It stores active files and programs for quick access. Essentially, as soon as you
boot up the computer, it starts loading the operating system into the memory so it can run. Then any
programs or files you have actively open and are working on are loaded into the system memory or the

RAM.

Hard Disk Drive/Solid State Drive

Logically, right after RAM, we have the long-term memory storage, which is your hard disk drives (hard

drives, HDD) or solid state drives (SSD), depending on your computer. The hard disk drive or solid state
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drive is your long-term memory or permanent storage. It stores data even when there is no more power

flowing to the system.

The difference between the hard drive and the solid state drive is that the hard drive has moving parts
inside of it. It has spinning disks, as you can see in the picture (fig. 6), which are those silver-looking
platters. The arm moves across the silver platters and reads and writes data on the platters which is

stored magnetically. The data is written to different sectors on the disk.

Figure 6: Hard disk drive (HDD)

The other difference between HDDs and SSDs is HDDs can make noise because it has moving parts. If
your hard drive starts making weird sounds, it’s probably an indication that something is wrong with the
driver or it is going bad. This could be a louder than normal whining sound or could sound like

something is grinding.
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The solid state drive (fig. 7) is a newer technology. It has been around for several years now and is
becoming more and more prevalent. It has no moving parts, it’s silent, and it’s typically smaller than a
traditional hard drive. SDDs are usually a smaller form factor and are the same size as the drives you see
in laptops. Most SSDs are in the 2.5-inch form factor, where HDDs are in the 3.5-inch form factor. They
are pretty much all electronic components because, again, there are no moving parts. One thing I'd like
to add about the solid state drive is that it works on a principle similar to how the RAM or the system
memory works, but it’s a slightly different mechanism because it’s permanent storage. On both the hard

drive and the solid state, you can write over or erase data that was previously written to the device.

Figure 7: Solid state drive (SSD)

Graphics card

The graphics card processes the visual information to send to the monitor. Not every computer has a
dedicated graphics card, as seen in the picture (fig. 8). Sometimes it is integrated or built into the CPU.
Your monitor will plug into a port directly on the motherboard, instead of the graphics card itself, if

there isn’t a dedicated graphics card. The graphics card helps reduce the load on the CPU, as the CPU
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doesn’t have to process all the graphics.
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Figure 8: Graphics card

Power supply

The power supply (fig. 9) essentially provides the “energy and nutrition” to the computer. It enables all
the components to run. There are wires going from the power supply to every component on the

system, though sometimes components like the CPU will draw power directly through the motherboard.
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Figure 9: Power supply

Peripherals

The peripherals are additional hardware that connects to the computer. Technically, your monitor is a
peripheral device, but you can’t really use the computer without it, because unless you have the
monitor, you can’t see what you’re doing or what’s going on. The peripherals are, for the most part,
external devices. Some examples of peripherals are keyboards, mice, monitors, speakers and

headphones, webcams, microphones, USB memory sticks, or even external hard drives.

Now that you have a basic understanding of the hardware of the computer, both inside and out, as well
as the basic functions each part performs, let’s switch gears and talk about the manager of the

computer: the operating system.
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Operating System

The operating system helps manage a computer’s memory and processes. It also manages the software
and hardware on a system and lets you communicate with the computer without knowing or having to
learn the computer’s language, because a computer speaks its own language. The operating system also

helps coordinate access to the computer hardware for various programs that are running.

When you’re using your computer, the various applications and programs you may have, like your word
processor or email client, can’t run without an operating system. An operating system is required for
them to function. The operating system provides a graphical user interface (GUI) for you to interact with
the computer. This is how you communicate with the computer without having to know its language or

without having to know commands to put into a prompt to tell the computer what to do.

Essentially, with the graphical interface, you just click something, and it runs multiple commands at
once. The graphical interface provides a visual representation of objects on the computer so you can

click and interact with those objects without having to know any commands or codes.

Simply put, the operating system is the glue that makes all the hardware and software work together. In
this book, we are primarily talking about the Windows Operating System, but there are many other
different operating systems out there as well. In addition to Windows, you have MacOS, which is the
operating system for the Apple computers, and Linux, which is an open-source operating system, of
which there are many different varieties. There are also mobile operating systems, which you may be
familiar with. There are iOS, Android, and Windows for Windows phones. There used to be a device
called Blackberry, which was pretty popular before the newer devices came onto the market. If you ever

encounter a Blackberry device, they have their own separate operating system as well.
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Navigating Windows

Because of the graphical user interface we just talked about, you can easily navigate the Windows
operating system and tell your computer what to do using your mouse and keyboard. When using your
mouse, by default the standard is a left click. There is also a right click, and if you’re left-handed, there is
a setting where you can reverse those for yourself so you can make the right click the left click, and the

left click the right click (fig. 10).

< Settings = m] X

@ Home Mouse

Find a setting 0 I Select your primary button Related settings

Left - [ Additional mouse options

Devices

Roll the mouse wheel to scroll :
Ef  Bluetooth & other devices Have a question?
Multiple lines at a time | Get help
L - |
1 Printers & scanners
Choose how many lines to scroll each time
I 0O Mouse a Make Windows better
i Give us feedback
Typing Scroll inactive windows when | hover over them
@ on
» Pen & Windows Ink
® AutoPlay
fi use

Figure 10: Primary mouse button option in the Settings App

Navigation Options*

Settings App > Devices > Mouse

*These boxes will be placed throughout the book and will show you how to get to the screens

shown in this book.
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Again, going back to our standard left click, if you need to open an icon or file folder, you just do a
double click. For menus, you single-click, and you can use the right click to bring up a special menu that
might have additional options or commands. Those menu options are going to vary based on where you
right-click and whether you right-clicked directly on the desktop or on a file or folder. We’ll talk about

that more later in the book.

Now that you understand how to use your mouse to do some basic navigation, let’s go to the desktop

and start looking at a few things we can do on our computer.

Desktop

When you first log in to the operating system, you are put onto the desktop, also sometimes referred to
as the Windows desktop. As you can see from the screenshot (fig. 11), this is just what my desktop looks
like on my computer. Now let’s walk through the various components of the desktop. We’ll look at the

desktop icons, the taskbar, the Start menu, the search bar, pinned apps, the task tray, the notification

tray and clock area, and the Action Center.

Figure 11: Windows desktop
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Desktop Icons

Let’s look at desktop icons first. These icons are a visual representation of an item on the system, like a
file, folder, or program. You double-click to open or launch whatever the icon represents. In this case, on
the little screenshot | took off my desktop (fig. 12), you see icons for This PC and the Recycle Bin. In this
case, you double-click both, and they open a File Explorer window to that particular section of the

operating system. We'll talk a little bit more about the File Explorer and what that is later in the book.

This PC

- |

Recycle Bin

Figure 12: Desktop icons

Taskbar

The next part of the desktop is the taskbar. The taskbar (fig. 13) contains several sections, and | will go
through each section here for you. Typically, you can find the taskbar at the bottom of the screen, but if
you’ve already done some customization of your operating system, you could have put it on the right
side, the left side, or even at the top of the screen, depending on where you want your taskbar placed.
The taskbar gives you quick access to various functions and the ability to open apps. The sections of the

taskbar are the Start menu, the search box, the pinned apps, and the clock, etc.

= P 1 XEEEEREEE EEE

Figure 13: Taskbar
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Start Menu

Let’s look at the first section of the taskbar: The Start Menu (fig. 14). It is represented by the Windows
logo, and if we’re talking about the traditional placement of the taskbar on the bottom of your desktop,
the Start menu is on the far left. If you click the Start button, that opens the Start menu, you will see a
list of all the installed programs you can launch. You will also see tiles on the right side. Some of those
tiles can be live tiles, and you can scroll through and add programs and customize how the Start menu
looks. We are not going to cover that here, as that’s more of an intermediate topic and we’re just

focusing on the basic skills here.

Recently added

Saturday

Most used 7

€ Google Chrome

Automate Control Center

File Explorer e w

Outlook 2016 Microsoft Edge Photos

Acrobat Reader DC MostiySunig

o 81°
Notepad 81 69° ﬂ:

Washington,... Phone Compa... Camera

1Password

© m
° o
3CXPhone for Windows -

77i Groove Music Movies & TV Microsoft Store
Zip

Access 2016

Acrobat Reader DC

L Type here to search

Figure 14: Start menu
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Also on the Start menu, if you right-click the Start button, a special menu pops up. This is another
example of a right-click menu. This is a special right-click menu because you only get this when you
right-click on the Start button or the Windows button. This menu gives you quick access to various
system settings and locations and to power options like log off, reboot, or different shut down options.

You can see that in the screenshot provided (fig. 15).

Apps and Features
Power Options

Event Viewer

System

Device Manager
Network Connections
Disk Management
Computer Management
Command Prompt

Command Prompt (Admin)

Task Manager

Settings
File Explorer
Search

Run

Shut down or sign out

Figure 15: Right click menu from the Windows Start button

Search Bar

The next component we’ll look at on the task bar is the search bar. From here, you can search the entire

operating system. You can pull up files, programs, and different settings that you can manipulate. The
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search box also gives search suggestions to perform internet searches, if it doesn’t find a match on the

computer to your search terms, or in addition to matches it might find.

If enabled, you can use the virtual assistant in Windows to search, which is Cortana. If you look at the
screenshot here of the search bar (fig. 16), the icon on the left, that circle, is the icon that denotes
Cortana. You can click there or click the mic, and you can speak to her. It’s similar to Siri, if you're

familiar with the iOS virtual assistant on the Apple devices.

O Type here to search O

Figure 16: Search bar or search box

Task View

The next component we're going to look at on the desktop is the Task View. Task View is represented by
the button just to the right of the search bar, as shown in the screenshot (fig. 17). In addition, we have a
screenshot of what Task View looks like (fig. 18). Task View allows you to see all the open windows on
your desktop. At the top of the Task View window is an overlay of your virtual desktops. Usually, when
you launch for the first time, you have just one, but you can click the plus button at the far right and add
additional virtual desktops. Here, you can remove and navigate and see what’s open on those other
virtual desktops. In the window itself the last item in focus is shown. If you have multiple monitors, you

get the same view on those different monitors and can see what’s open on each monitor.

E

Figure 17: Task View button
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Figure 18: Task View

Pinned Apps

The next section of the desktop we’re going to look at, still on the taskbar, is the pinned apps. As you
can see, on my system, | actually have a lot of apps pinned, because there are a lot of applications | use

quite frequently or prefer to have quick access to (fig. 19).

B O 3

Figure 19: Pinned apps

You can have as many or as few pinned apps as you like. Just keep in mind that if you add too many,
eventually it will get to the point where you’ll have to start scrolling through them, which defeats the
purpose of having them pinned. You will want to keep that in mind and keep the pinned apps to a

minimum, if possible. Obviously, | do quite a bit, so | prefer to have a lot more there for quick access.
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Anything you pin here you can get quick access to, with one-click launch. When an app is pinned here,
it’s always going to be in the same spot. If you want to see if an app is open, simply look below it, and
see if there is a light blue line under it. For example, if you look at the Google Chrome icon on my pinned
app section (fig. 19), there’s a little light-colored line underneath it. That indicates that the app is

currently open and active somewhere on the system.

If you right-click any of the icons in pinned apps, a right-click menu appears (fig. 20). These menus vary
depending on which program you’re clicking on. Some only have an option for you to pin or unpin, or
close the application if it’s open. Others, like, for example, Google Chrome, show you websites you’ve
pinned there for quick access, recently viewed websites, or recently closed webpages or websites. You

can drag the icons here to reorder them however you like.

0 lock

@ 1Password

'2;5 Unpin from taskbar

Close window

® © #H &

Figure 20: Example of a right-click menu from a pinned app

Task Tray

Just to the right of the pinned app section is the task tray. These are the other applications that are open
but are not pinned to the task bar. You can right-click and then pin them and you’ll see similar options

on the right-click menu as you did when you right-clicked on a pinned app (fig. 21). The only real
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difference here is these applications are not pinned to the taskbar, so they show to the right of all your

pinned applications. Again, you can reorder these too.

Task View

Desktop

Paint 3D

Pin to taskbar

Close window

Figure 21: Example of a right-click menu from a non-pinned app in the task tray

Notification Tray & Clock

Now we’re going to look at the notification tray and clock section. You can see the system and
application notifications show up here in the bottom right portion. In the screenshot (fig. 22), you can
see a white arrow pointing up. If you click that, you can see additional icons for what | call applets, that
essentially show up and denote different programs on the computer for applications that are showing
up in the notification tray.

416 PM

{ 33
NO@®BELD L0

Figure 22: Notification tray & system clock
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You can choose to show more or fewer of these icons without having to click the arrow. Also, with the
clock being here by default, you can see the current time and the current date. If you click the clock, you

can see the calendar.

You can also click the icons that show up in the notification tray, to get additional actions and options.
There are different options whether you do a left click or a right click. Again, the right click is going to

bring up additional menu options. This is a special menu, based on what you are clicking on.

Action Center

The last component we’re going to look at on the desktop is the Action Center. The icon for the Action
Center (fig. 23) looks like a little sticky note with an arrow pointing at the bottom, or maybe a little note
box. Right now, mine’s blank, but if you have new notifications, the inside actually fills with what look
like lines, like there’s actually something there to read. These lines indicate there are some new

notifications in your Action Center.

Figure 23: Action Center icon

In the Action Center (fig. 24), you can see the notifications from the system in various applications, like

you can in the Notification Center on your mobile device, like in iOS, for example.
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@ CloudApp

A link to your file is ready to share!
€)

ste)

D

Focus assist

Night light

Figure 24: Action Center

Then, at the bottom of the Action Center, you see several buttons. That gives you quick access to a few
system settings. Depending on the type of device you have, you may have more or fewer buttons than
show up there. If you have a laptop, more buttons will likely show up, like for controlling your display

brightness and the screen, or maybe some presentation options.

Then, of course, in the notifications, you can hover over those and close those out or click to see more

info, if they have more to provide.
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The Desktop Itself

You probably noticed that most of the desktop components we’ve looked at are located on the taskbar,

and that is where you launch most apps and files on your computer that you want to work with.

Before we finish up looking at the taskbar and the desktop, | want to mention one final part of the
desktop: the desktop itself. When you open any of the files or applications from any of these other
sections we just talked about, they open and are active on the desktop, but they are not actually

desktop components.

Now that you understand the desktop and what it consists of, let’s talk about the File Explorer and start

navigating around Windows.

File Explorer

We actually mentioned the File Explorer a little earlier in the book, and now we’re going to look at it in
more detail. The File Explorer is denoted by the file folder icon, which is located, by default, in your
pinned app section on the task bar (fig. 19). If you look at that screenshot, you will see the File Explorer
almost to the far left. The File Explorer is essentially the way you do most of your navigation in

Windows, because it allows you to access the file system.

When you left-click on the File Explorer and first open it, it defaults to the Quick Access view section.
The Quick Access view shows you the folders you frequently access and the files you have recently
accessed. If you look on the left of the File Explorer window, you have the file tree, and on that file tree
you can see various locations, like This PC. In earlier versions of Windows, as you may recall, This PC
used to be called My Computer, or Computer. In this Window, if there are any folders you access on a

regular basis and want to get to quickly, you can pin those in the top of the file tree under the Quick
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Access section. There’s also a search box, which you can use to search for any file or folder in the current
location you’re viewing, and you can see that location in the address bar at the top or near the top of

the File Explorer window. This screenshot (fig. 25) is where you see Quick Access listed.

P B B - | File Bxplorer

File Haome Share View o
A s » Quick access v & Search Quick access -l
A ~
# Quick access ~ Frequent folders (13)
‘ Downloads o Downloads Dropbox 2 ResTech Solutions, LLC Desktop
P ' This PC < David Levine g u This PC
& Dropbox + o+ ) ” @' x -
w ResTech Solu
Documents Pictures
[ Desktop * ﬁ This PC = This PC i | N £ .. H 'H Ec
4| Documents # * L (]
| Pictures + Videos .
al® g - gm:pc F | | l N EEEE
m S ’ © <@
B Vvideos »*
u ]
L )
H I .
@ ~ Recent files (20)
— B w ] [ )]
s
& Dropbox A RN EE W O W »
¢ OneDrive o= W L L mm
[E— | RN EE W O N ®
= u | W |
“J 3D Objects o L
| ]
[ Desktop H H § . u w
|=| Documents u n il
J Downloads &= [ B | u = m u
. ¥ i ] ] n ¥
33items ez &=

Figure 25: File Explorer, default Quick Access view

Navigation Options

Folder icon pinned on the taskbar (default)

Search Bar > Type “File Explorer” > Click on “File Explorer”

Click the Start Button (opens Start Menu) > Click the File Explorer icon
Right click on the Start Button > Click on “File Explorer”

Use the Win+E key combo

agkrwnhE

The next component of the File Explorer I’'m going to bring your attention to is called the ribbon bar. I've
provided three screenshots here (figs. 26-28) of the three tabs you will see everywhere you use the File

Explorer, regardless of what section of Windows you’re in or navigating in.
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B Documents

File Home Share View o
)E?’ L;l] u b Cut Lb] x ;E [:J New item ~ \/] 1 Open v EE Select all
G [ W Copy path * £ Easy access ~ = Edit | Select none
Pin to Quick Copy Paste

ste o Move Copy Delete Rename New Properties
access [] Paste shortcut | “tov  to~ - folder b4

Clipboard Organize New Open Select

&) History D'Dlnver! selection

Figure 26: File Explorer ribbon bar showing the Home tab

File Home Share View 0
@& — 2 @ Burnto disc [
2 = [ 8 ¢
s = Print 2B Specific people...
Share Email  Zip — Remove Advanced
& Fax T access security
Send Share with

Figure 27: File Explorer ribbon bar showing the Share tab

] . - | Documents

File Home Share View o
E [l Preview pane B Bxtra large icons =] Large icons 55 Medium icons I f' Group by ¥ [ ttem check boxes 3
Small icons BB List == Details ‘ [TH] Add columns ~ [] File name extensions e
Navigation &= G= o Sort Hide selected Options
pane > (8 Details pane sf= Tiles == Content 7 by~ [ Size all columns to fit ] Hidden items tams )
Panes Layout Current view Show/hide

Figure 28: File Explorer ribbon bar showing the View tab

The ribbon bar provides quick access to actions you can take. The standard and common tabs you’ll see
are Home, Share, and View, and then depending on what you’re doing or where you’re at, you’ll see
some additional tabs to the right of these three. These will have some special actions specifically to

something you’re doing or maybe a file or folder you’re working with.

Some of these actions are also available via the standard right-click menu or various other right-click

menus. You can also select one or more files or folders to take action against.

This PC

Now let’s look at the This PC section of Windows (fig. 29). In this section you can see all the devices and
the network drives attached to your computer. You can also see how much space is used up and how

much is available for each. This section allows you access to several of the folders from your user folder.
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The This PC area is one of my favorite places to go because | can do a lot of tasks here and glean a lot of

information from the computer. One of the things | like to do is right-click on This PC and go to

Properties, which will bring up the basic system information about the computer if it's needed.
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Figure 29: File Explorer showing This PC section

C: Drive

Navigation Options

File Explorer > This PC

The next thing we will look at is the C: drive, which is the main drive of the computer. You can access the

C: drive through the This PC section. The C: drive is essentially the drive the operating system is installed

on. By default, this is usually where everything is put. Now, of course, it can be specified that some
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programs get installed on a different drive if available, or your documents and files can be stored on a

different drive if available, but by default it’s all going to be on the C: drive unless specified otherwise.

Now | want to point out a few of the main folders that you’ll probably be in a lot or see referenced a lot
on the system. You will see that you have two Program Files folders. One of them has (x86) after it. Here
is what this means: there are 32-bit and 64-bit applications, and the 32-bit applications go in the (x86)
Program Files. I’'m not going to talk in detail about these folders, as that is an advanced topic. | just want
to let you know that’s why there are two different folders. That’s basically how the different programs

were written.

Navigation Options

File Explorer > This PC > C: Drive

Users Folder

The next folder is the Users folder. That’s where the user folders are kept for any user account on the
computer. Basically, if any person logs in with their own account or a different account, there will be a
user folder for them. In the user’s folder, there’ll be the individual document folders for the files for that

user account on the computer.

Navigation Options

File Explorer > This PC > C: Drive > Users
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Windows Folder

Next is the Windows folder. This is for the operating system files, which contain all the files Windows
needs to function. Typically, you don’t need to go into that folder, and, in fact, | advise that you don’t go

into or do anything with that folder. | just want to point out what it is.

Then, of course, as you can see in the screenshot from my C: drive (fig. 30), there are other files and

folders. These typically vary from computer to computer, but again, the Program Files folders, the Users

folder, and the Windows folder are on every Windows computer you have.

Drive Tools [REZIREN (€3]
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5 Documents # ESD File folder
[& Pictures # inetpub File folder
4 Recipes Py Intel File folder
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B Videos 4 Program F!Ies File folder
Program Files (x86) File folder
al Day ResTechSolutions File folder
ARIWIEREp oS Users File folder
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[5] Documents 5] Fastboot Text Document 1KB
& Downloads _] InjectintoProcess crash File 1KB
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= Pictures J setup Text Document 1KB
) 15l siv Text Document 1KB
B Videos B sr2 Text Document 1KB
‘= Local Disk(C) v | 1 timelock / :51 PM Text Document 1KB v
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Figure 30: The C: drive folder

Navigation Options

File Explorer > This PC > C: Drive > Windows
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Now that we have explored This PC, let's move on to another section of Windows, the Network section.

Network Section

In the File Explorer, as you can see on the left side in the screenshot on the file tree (fig. 31), there’s a

Network section you can click on. This will show you all discoverable devices on the network, or at least

all of those your computer is able to detect, depending on your computer settings. You may be able to

connect and browse to these various devices, though some of them, depending on how they are

configured, will require a login. You can see shared devices in this section as well.
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ﬁ @) PlayOn: David-Home
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Figure 31: Network section in Windows File Explorer

Navigation Options

File Explorer > Network (in the left side panel)
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This is one way you can access other locations and devices for sharing over the network, but there are

also other ways for being able to do some network sharing of devices, files, and folders.

Hidden Files & Folders

The final piece | want to mention when navigating Windows is hidden files and folders (fig. 32). By
default, there are some files and folders that are hidden on the operating system. These are usually
items that contain settings or files that shouldn’t be deleted or that shouldn’t be modified or accessed
by the standard user. These files and folders can be accessed, but many times you’ll need to know

where they are to get to them. If you don’t, there is a setting that can make these visible. But again, by

default, they will not show, as we don’t want to mess with these hidden files and folders.
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Backup » inetpub 5/19/2018 3:13PM  File folder
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Figure 32: Windows Explorer showing hidden folders on the C: drive, the folder icon is dimmed
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Now you understand the basics of the File Explorer. In the next section we are going to explore the
Control Panel and the Settings app and start looking at how you can configure the Windows operating

system.

Configuring Windows

Control Panel & Settings App

To start, | want to talk about the Control Panel versus the Settings app. In this book we’re primarily
focused on Windows 10, as that is the most current operating system. Previous operating systems only
had the Control Panel, which is where you would go to access all the Windows settings and do a lot of
the Windows configurations. In the newer Windows operating systems, however, | believe starting with
Windows 8, and definitely with Windows 10, you have the Settings app. This is where most of your
settings are now controlled. Now, even though you use the Settings app, there are still instances where
it sends you back to the Control Panel, because not everything has been migrated over to the Settings
app yet. There are still some instances where the Control Panel has more options for certain settings

and functions than the Settings app.

The Control Panel (fig. 33) is still accessed via the File Explorer. It also has its own shortcut, whereas the

Settings app, as its own separate application, is not accessed through the File Explorer.
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Control Panel = O X
L v > Control Panel v &  |search Control Panel L
Adjust your computer's settings Viewby: Category ¥

System and Security P User Accounts
Review your computer's status HE @ Chsiige sccount type

Save backup copies of your files with File History
Backup and Restore (Windows 7)

;" [, Network and Internet
View network status and tasks
, / Hardware and Sound
%‘ View devices and printers
Add a device
Programs
[‘] Uninstall a program

Appearance and Personalization

Clock and Region
Change date, time, or number formats
Ease of Access

Let Windows suggest settings
Optimize visual display

@ & &

Figure 33: Control Panel in category view

Navigation Options
Open Control Panel

1. Search Bar > Type “Control Panel” > Click on “Control Panel”
2. Open the run dialog (Win+R key combo) > Type “Control Panel” > Click OK

Navigate Control Panel

e The “View by” drop down dictates how the various settings within the Control
Panel are displayed

e The category view will group settings into a cohesive branch to allow you to
find settings more easily

e The large icon view will show all settings in alphabetical order alongside a
larger icon

e The small icon view will show all settings in alphabetical order alongside a
smaller icon

I have personally found when using the Settings app that it’s more organized than the Control Panel and

things are broken down a little bit better and sectioned off more. The various sections have their own
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sub-sections of settings, as you can see in the screenshot (fig. 34), which is the main view of the Settings

app when you first open it. Earlier you saw this screenshot (fig. 33) of the main screen of the Control

Panel by the default category view, and in the Control Panel you can change that to a detailed list view

of the individual options.

Settings

Q

Update & Security

backup

Windows Update, recovery

Windows Settings

- Devices D Phone @ Network & Internet
Bluetooth, printers e Link your Android, iPhone Wi-Fi, airplane mode, VPN

E:_ Apps R Accounts g‘-\$ Time & Language

- defaults, optional o ounts, email, sync, Speech, region, date

1, Ease of Access el Privacy
Narrator, magnifier, high Location, camera

contrast

Figure 34: Settings app on main category screen

PwphPE

Navigation Options

Start Menu > Click on the settings icon (gear cog icon)
Right click on the Start Button > Click “Settings”
Search Bar > Type “Settings” > Click on “Settings”
Action Center > Click on “Settings”
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Both the Control Panel and the Settings app are searchable, so they both allow you to search and find a
particular setting you're looking for. However, as new Windows settings are added to Windows or are
able to be tweaked, they will only be found in the Settings app. It is my understanding from reading
various updates and technical documentation that eventually the Settings app will replace all the
functionality of the Control Panel. | don’t know when this will happen or if it actually will, but it’s my
belief from the information I've read that this will eventually happen, because with each iterative

update of Windows, more and more settings show up in the Settings app.

Now let’s take a look inside the Control Panel and Settings app at all the different things you can

configure on your computer.

Account Settings

Currently, you have two different options when accessing Microsoft Windows: The default option
Microsoft wants you to use is a Microsoft account, but the other option is to create a local account. If
you are in a work environment, there’s a third option, which is a domain account on your company’s
domain. A domain account is similar to a local account, but it’s not local to just one computer. The two
accounts we will go over in this book are those you will use on your own home computer: the Microsoft

account or the local account.

There are some advantages to using a Microsoft account versus a local account. First, there are certain
settings or options in the operating system that you can only use by having a Microsoft account. Now, of
course, by having the Microsoft account, you are handing over some control and a little more
information to Microsoft, so there is a tradeoff, but if you’re comfortable with that, it is a pretty good

option.
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Second, if you have multiple computers you log into and you have a Microsoft account, many of the
settings you have set on one computer can follow you to another computer. For example, your desktop
background can be the same computer to computer, and you don’t always have to be tweaking your
settings. Or say you get a new computer and you are moving over to it, if you have a Microsoft account
and sign into it on the new computer, it’ll pull over a lot of your settings and save you some time in that

new setup.

With the Settings app, you have the ability to reset your password and change your sign-in options (fig.
35). You can also join a work network, and you have options for your email and various app settings for

different applications on the computer.

Your info

Have a question?
Get help

Make Windows better

Give us feedback

DAVID LEVINE

| .
Administrator

Billing info, family settings, subscriptions, security settings, and
more

Manage my Microsoft account

Sign in with a local account instead

Create your picture

@ Camera
D Browse for one

Backgrounds Wallpapers HD

Figure 35: Account settings in the Settings app
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Power Settings

The next settings | want to talk about are the power settings. On a desktop computer, in the Settings
app, you have two basic power options you can set: your screen sleep timer and your computer sleep

timer (fig. 36). If you have a laptop, you’ll see those same options repeated, but for your laptop battery,

Navigation Options

1. Settings App > Accounts
2. Control Panel > User Accounts

since you can have different settings for the battery if you’re unplugged from the power.

Power & sleep
Screen

When plugged in, turn off after

Sleep

When plugged in, PC goes to sleep after

Never v

Save energy and battery life

Set how quickly your screen goes to
sleep when you take a break from
your PC.

Get more info about saving PC
energy

Related settings
Additional power settings

Have a question?
Get help

Make Windows better
Give us feedback

Figure 36: Power settings in the Settings app
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Navigation Options

1. Settings App > System > Power & Sleep
2. Control Panel > View by Large/Small icons > Power Options

There are also different options for powering off a computer. Looking at this screenshot (fig. 36), in the
Settings app for the sleep setting, there are essentially two similar settings: Sleep versus Hibernate. By
default what it offers here is Sleep. Sleep will save your work and settings to memory and put your
computer in a low-power state. This gives you a quicker wake time when you come back to turn the

computer back on or bring it back to life.

The Hibernate option can also be found through the power-off option in the Start menu*, if you right-
click there or in some other section where you can control the various ways to shut down the computer.
Hibernate takes any open documents and programs and saves them to the hard drive or solid state
drive, whatever you have, and then powers off the computer. When you turn the computer back on, it’ll
reload that saved session, and you’ll basically be back to where you were before you turned the

computer off.

*By default, the hibernate option is not enabled and will have to be enabled from the Control

Panel. This change is a more advanced skill, as you have to dig into the settings.
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£ System Settings

< « 4 i@ » ControlPanel » Hardware and Sound > Power Options > System Settings ~|@ | Search Control Panel el

Define power buttons and turn on password protection

Choose the power settings that you want for your computer. The changes you make to the settings on this
page apply to all of your power plans.

& Change settings that are currently unavailable

Pawer and sleep buttan settings
@ When | press the power button: | Shut down bt

@ When | press the sleep button: Sleep ~

Shutdown settings

Turn on fast startup (recommended)

This helps start your PC faster after shutdown. Restart isn't affected. Learn More
Sleep

Show in Power menu.

Hibernate

Show in Power menu.

Lock

Show in account picture menu.

Save changes Cancel

Figure 37: Power option settings in Control Panel to modify power options

Navigation Options

Control Panel > View by Large/Small icons > Power Options > Choose
what the power buttons do (left side menu)

There are also other options or more advanced options for the power settings. If you're in the Settings
app, you can see in Related Settings on the right, Additional Power Settings. If you click that, it launches
you into the Control Panel, as you can see in this next screenshot (fig. 38). Here you’ll see some more
advanced power setting options, and you can set a power plan. These plans can be customized, and you
can do a whole lot more. I’'m not going to go into a lot of detail here, because that’s a more intermediate
skill, but | wanted to show you this so you can poke around here and see what you can do. You have the

ability to do more than just what those two options offer you in the Settings app.
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= O X

£ Power Options

M @ > Control Panel > Hardware and Sound > Power Options v 0 Search Control Panel yel

Control Panel Home o
Choose or customize a power plan

Choose what the power A power plan is a collection of hardware and system settings (like display brightness, sleep, etc.) that manages

buttons do how your computer uses power. Tell me more about power plans
Create a power plan Preferred plans
Q2 S_h"l“e when to turn off the (@ Balanced (recommended) Change plan settings
I
i Automatically balances performance with energy consumption on capable hardware.
% Change when the computer
sleeps (O Power saver Change plan settings

Saves energy by reducing your computer's performance where possible.

Show additional plans

See also

User Accounts

Figure 38: Additional power settings in the Control Panel

Navigation Options

Control Panel > View by Large/Small icons > Power Options

Windows Update Settings

The next configuration options | want to look at are the Windows update settings (fig. 39). These are
controlled now via the Settings app, and you can set active hours when updates can be applied. Basically
this tells your computer the usual hours you’re using the computer, so it doesn’t do any updates or
system reboots during that time. Then the system knows that anytime outside those hours, it can go
ahead and run the updates. Just keep in mind that there are updates that require the system to

automatically reboot the computer after the update, so just be sure you save any of your work when
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you walk away from the computer at the end of the day, because it may not be there when you come

back, if the computer reboots.

= a X
Windows Update
Updates available WhatsHew
Last checked: Yesterday, 9:58 AM Your device recently got the latest
Windows 10 update with new
HP driver update for HP LaserJet M1530 MFP Series PCL 6 features and important security

Status: Pending install updates.

See what's new in Tips
We'll automatically install updates when you aren't using your device, or you can

install them now if you want.

Looking for info on the latest

updates?
Change active hours P

Learn more

View update history

Advanced options Related links
Check Storage
OS build info

Have a question?
Get help

Make Windows better

Give us feedback

Figure 39: Windows Update in the Settings app

Navigation Options

Settings App > Updates & Security > Windows Update

Also here, in the Update Settings sections, you can see a history of what updates were applied and when
(fig. 40). There are also some advanced settings, so you have options for controlling how the updates
work (fig. 41). You can pause updates and choose when updates are installed. There are other things
you can do here as well, but those are at a higher level than what | am teaching in this book. Again, feel

free to poke around and familiarize yourself with what you can do.
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<« Settings — [m] X

@ View update history

Uninstall updates Have a question?

. Get help
Recovery options

Update history
v Feature Updates (1)

Feature update to Windows 10, version 1803
Successfully installed on 5/19/2018
See what's new in this update

v Quality Updates (5)

2018-07 Security Update for Adobe Flash Player for Windows 10 Version 1803 for x64-based Systems (KB4338832)
Successfully installed on 7/18/2018

2018-07 Cumulative Update for Windows 10 Version 1803 for x64-based Systems (KB4338819)
Successfully installed on 7/18/2018

2018-06 Cumulative Update for Windows 10 Version 1803 for x64-based Systems (KB4284835)
Successfully installed on 6/20/2018

2018-06 Security Update for Adobe Flash Player for Windows 10 Version 1803 for x64-based Systems (KB4287903)
Successfully installed on 6/15/2018

2018-05 Security Update for Adobe Flash Player for Windows 10 Version 1803 for x64-based Systems (KB4103729)
Successfully installed on 5/19/2018

> Definition Updates (50)

> Other Updates (2)

Figure 40: Windows Update history in the Settings app

Navigation Options

Settings App > Updates & Security > Windows Update > View update history
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Settings
@ Advanced options

Update Options
Note: Windows Update might
Give me updates for other Microsoft praducts when | update Windows. update itself automatically first
Q o when checking for other updates.
n

Configure automatic device setup
after an update under the Privacy
@ Off section in Sign-in options

Automatically download updates, even over metered data connections (charges may apply)

We'll show a reminder when we're going to restart. If you want to see more notifications about restarting, turn this on.
Have a question?

@ off Get help

Pause Updates

Temporarily pause updates from being installed on this device for up to 35 days. When updates resume, this device will need to get
the latest updates before it can be paused again.

@D or

Pausing now will pause updates until 8/31/2018

Choose when updates are installed
| Choose the branch readiness level to determine when feature updates are installed. ‘Semi-Annual Channel (Targeted)'

| means the update is ready for most people, and ‘Semi-Annual Channel’ means it's ready for widespread use in
organizations.

| Semi-Annual Channel (Targeted)

A feature update includes new capabilities and improvements. It can be deferred for this many days:

8 v

| A quality update includes security improvements. It can be deferred for this many days:

g

Delivery Optimization

Figure 41: Advanced settings for Windows Update in the Settings app

Navigation Options

Settings App > Updates & Security > Windows Update > Advanced options

Storage Monitoring

The next configuration settings | want to cover are the storage monitoring settings. In the Settings app,
you’ll see some information that is similar to what you saw in the This PC section we looked at earlier
(fig. 42). This gives you a little more information because it shows you the used and free space for all the

drives and shows you what the total drive space is for that particular drive.
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Storage

Local storage Keep clutter off your PC

When Storage sense is turned on,
it'll free up space only when your PC

This PC (C)) - 476 GB is low on space. To clean up unused

(-

410 GB used 66.0 GB free files now, select Change how we
free up space > Clean now.
VM Drive 1 (E)) - 238 GB Get help freeing up space

{

208 GB used 29.6 GB free
Have a question?
Get help

Plex Media Storage | (F) - 3.63 TB

{

3.34 TB used 304 GB free

Plex Media Storage Il (G:) - 3.63 TB N
Make Windows better

{

2.68 TB used 979 GB free Give us feedback
VM Drive 2 (H:) - 256 GB .

~~ I
89.4 GB used 166 GB free

Storage sense

Windows can automatically free up space by getting rid of files
you don't need, like temporary files and content in your recycle
bin

@D off

Change how we free up space automatically

Free up space now

More storage settings
Change where new content is saved

Manage Storage Spaces

Figure 42: Storage settings in the Settings app

Navigation Options

Settings App > System > Storage

Here, you can access tools to help you manually manage your storage and free up space. You can also
set it up to automatically free up space when the operating system determines it needs to remove files
to give you more space to work. You don’t want to let your main drive, your C: drive, run low on space.
When this happens, eventually the operating system won’t function, because it doesn’t have enough
space to write information back to the hard drive or your solid state drive so it can function normally.
I've seen this happen. A lot of times if the machine becomes slower or unresponsive or sluggish, it’s

because it’s running out of space. As soon as you clear up space, it returns to normal. So it’s always a
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good idea to keep an eye on how full your drive is getting. You can also come here to change where your

content is saved.

Device Behavior

The next thing we will look at within the Settings app is device behavior. In this section is AutoPlay. By
default, AutoPlay is turned on for media and devices. AutoPlay is when you plug in a USB or put ina CD
and you get a pop-up asking what you want to do with this device. These settings control what happens
when you attach certain devices. You can set AutoPlay to default for removable drives, memory cards,
and other listed devices. On your computer, you may see more or less what’s here on my screenshot
(fig. 43). By default, you always have the removable drives and the memory cards on AutoPlay, and, of

course, here on mine | have the Apple iPad because at one point | hooked up my iPad to my computer.

AutoPlay

Use AutoPlay for all media and devices Related settings
Q On Default app settings

Choose AutoPlay defaults

Have a question?
Removable drive Get help

| Open folder to view files (File Explorer) v |

Make Windows better

Memory card Give us feedback

| Choose a default v |

Apple iPad

| Choose a default v |

Figure 43: AutoPlay settings in the Settings app

© 2018 ResTech Solutions



Mastering Computer Basics in Windows OS Page |48

Navigation Options

1. Settings App > Devices > AutoPlay
2. Control Panel > View by Large/Small icons > AutoPlay

There are multiple options you can set for AutoPlay, and those include import, play, file explorer, do

nothing, or ask every time.

Notification Settings

The next thing | want to show you is where to configure the notification settings (fig. 44). In the
Notification Settings, you can set where notifications show, you can set what notifications show, and
you can also customize the quick actions. This is what we saw in the Action Center earlier when looking
at the desktop components. Those quick actions, again, are buttons at the bottom of the Action Center,

and you can use the quick access there to toggle settings or bring up sections in the Settings app.
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Notifications & actions

Quick actions

Press and hold (or select) quick actions, then drag to rearrange
them. These quick actions appear in action center.

Get the notifications you want

on that app.
Get more info about notifications

To have an app start sending you
notifications, go to Get notifications
from these senders, and then turn

Add or remove quick actions Have a question?
Get help
Notifications

Show notifications on the lock screen Make Windows better

Give us feedback
@ on

Show reminders and incoming VolP calls on the lock screen
@ on

Show me the Windows welcome experience after updates and
occasionally when | sign in to highlight what’s new and suggested

@ on
Get tips, tricks, and suggestions as you use Windows
@ on

Get notifications from apps and other senders

@ on

Figure 44: Notification and action settings in the Settings app

Navigation Options

Settings App > System > Notifications & actions

Again, | encourage you to go through this section on your own and check out the settings to see what

options are available and how you can customize your notifications in the quick actions.

If you scroll down on that screen we were on, to the bottom half of the screen, you can see a list of
various applications. There are more than | can show in this screenshot (fig. 45), but you can choose
which apps can provide notifications. Again, this is similar to using a mobile device and determining

which applications have permission to show notifications and which don't.
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= a X
Notifications & actions
Get notifications from these senders
Select a sender to see more settings. Some senders might also have
their own notification settings. If so, open the sender to change
them.
é Alarms & Clock @ on
On: Banners, Sounds
AutoPlay Q On
On: Banners, Sounds
=< Backgrounds Wallpapers HD Q On
sl On: Banners, Sounds
Calendar (via Calendar) @ on
On: Banners, Sounds
CloudApp Q On
On: Banners, Sounds
Cortana Q On
On: Banners, Sounds
"ee  Dropbox O On
. b ., On: Banners, Sounds
Feedback Hub @ on
On: Banners, Sounds
& FileZilla @ on
On: Banners, Sounds

Figure 45: Notification settings for applications in the Settings app

Display Settings

The next section of configurations we want to look at in the Settings app is the display settings. The
display settings show you all the detected monitors and the orientation/layout of those monitors, and
allows you to arrange the monitors however you want. | recommend you arrange them to match the

physical orientation and layout of your existing monitor setup.

You can see | currently have three monitors (fig. 46). | had a fourth that would’ve shown here, but that
one died, so | unhooked it. I've got monitor one at the top left, monitor two at the bottom left, and

monitor three at the bottom right.
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Display

Select and rearrange displays

Select a display below to change its settings. Some settings are applied to all displays.

Color

Night light
@D off

Night light settings

Scale and layout

Change the size of text, apps, and other items

| 100% (Recommended)

e |

Advanced scaling settings

Resolution

| 1920 x 1080 (Recommended) v

Orientation

| Landscape

- |

Sleep better

Night light can help you get to
sleep by displaying warmer colors
at night. Select Night light settings
to set things up.

Get help setting it up

Have a question?
Get help

Make Windows better

Give us feedback

Figure 46: Display settings in the Settings app

Navigation Options

Settings App > System > Display
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The next setting after the monitor orientation setting in display settings is the night light. When it’s

enabled, based on how you have the settings set and what time it comes on, and if you set it to come on

automatically, you can get a warmer color hue at night. This takes out all of the blue light, so it’s a little

easier on your eyes and makes it easier to go to sleep.

Some other options you can set here are the scale, the resolution, and the orientation for each monitor.

Typically, you won’t really have to mess with the scale unless something is just hard to see, it’s too big or
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too small. If you have a high-resolution monitor, you may need to adjust this to make things look a little

bigger. That’s something I've frequently seen with the hi-res monitors, like 4K monitors.

Now, scroll a little further down on the screen, and some additional options show up (fig. 47). If you
have multiple monitors like | do, you can choose what to do with them. You can extend the desktop and
have it stretch across both monitors, or you can duplicate the screens and have the same thing showing
on both monitors. For example, you may want screen A and screen B to show the same thing, maybe
because you have the monitor at an angle so somebody else can see what you’re doing. You can also

choose which monitor is your main display.

Display

| et Give us Teedback

Color

Night light
@D off

Night light settings

Scale and layout

Change the size of text, apps, and other items

100% (Recommended) v

Advanced scaling settings

Resolution

| 1920 x 1080 (Recommended) v|
Orientation

| Landscape v |
Multiple displays

Multiple displays

| Extend desktop to this display v I

D Make this my main display

Advanced display settings

Graphics settings

Figure 47: Additional display settings in the Settings app
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Personalization Settings

The final configuration setting we will look at is the personalization settings (fig. 48). Personalization
settings are settings for your background, colors, lock screen, themes, fonts, Start menu, and taskbar.
Everything here is fairly self-explanatory. I’'m not going to go into too much detail here, but again, just
click through and explore each one on your own. Most of the time, the choices here are as simple as

picking an image or color, font or theme. A theme is when you choose a combination of background,

color, and sounds. You can choose a premade theme as well.

& Settings

@ Home Background

Find a setting

o

Personalization

Background

Colors

)
Cd Lock screen
(=4}

Shemes Background

‘ Picture ‘

=

Fonts

Choose your picture

Start N s
= TESkbar . % . .

Browse

Choose a fit

[ Fin

Preview your changes

t look.
and more, select

Go to Themes

Related Settings
High contrast settings

Sync your settings

Have a question?
Get help

Make Windows better

Give us feedback

Figure 48: Personalization settings in the Settings app

Navigation Options

Settings App > Personalization
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Now we have looked at all of the configuration settings on your computer. Let’s switch gears and learn

about your computer’s network and internet options.

Network & Internet Options

Wired vs. Wireless Connections

The first thing | want to talk about in this section is wired versus wireless connections. Typically you're
going to choose one of these two options based on the type of computer you’re using. If you have a
desktop, my recommendation is it should always be wired, if that is an option. Most desktops have the
ability to be wired in by an ethernet cord. The ethernet cord looks like a big phone cable and plugs into a
wall jack, network switch, or router. If you’re not familiar with what the wall jack or network devices are
or look like, they are essentially a big phone jack in the wall, or devices with several of the big phone
jacks. The reason | suggest that you connect to the internet via an ethernet cord is because the wired

connection is typically faster and more reliable than the wireless one.

If a wired option is just not possible, you can get wireless adapters for your desktop. They come in two
different types. You can get a USB wireless adapter that you just plug into the USB port, or you can get
an internal card. Typically if it’s a long-term need, I'd recommend getting an internal card that has an
antenna sticking out of the back, because it is less prone to potential damage versus the USB wireless
adapter. With the USB adapter, you might accidentally hit the adapter or someone might walk by and

bump it, and it could become damaged. That’s why | usually recommend a wired connection, if possible.

Now, if you have a laptop computer, by default they always have the wireless card built into them
because it’s mobile and smaller. A lot of times, especially with the newer laptops and Ultrabooks you

can get, there are not even ethernet adaptors on them anymore, to save space. If they don’t have an
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ethernet port and you do need to wire it in, you can get an ethernet adapter. This is usually a USB device
that plugs into a USB port that has an ethernet port on the other end. I've actually used these with my

laptops on several occasions, and they are very easy to use and another good option.

Again, to recap, desktops are typically wired, and laptops are typically wireless. Now let’s talk about how

to join your computer to a network using either type of connection.

Joining to a Network

When joining to a network, it is done through the Settings app. You can see here in the screenshots I’'m
showing you in this section (figs. 49-50), that there are different options. | want to show you how to set

up a work versus a home network, because you’ll see these options as you go through the settings.

Access work or school

Connect with work and school

Select Manage or disconnect from

Get access to resources like email, apps, and the network. work or school, and then select
Connecting means your work or school might control some things Connect to access resources on

on this device, such as which settings you can change. For specific your work or school network. The
info about this, ask them. Connect option will also let you set

up a work or school account if you
don't have one already.

~:|-' Cannect Get more tips

Related settings

Add or remove a provisioning
package

Export your management log files
Set up an account for taking tests

Enroll only in device management

Have a question?
Get help

Make Windows better

Give us feedback

Figure 49: Join a work or school network settings in the Settings app
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Navigation Options

Settings App > Accounts > Access work or school

The work network gives you options to join a domain. You’ll be able to access the network resources on
that work network. When joining a work network, many times some of the settings of that network are

controlled by the network itself or were set by the network admins.

The home network is your network at home. You can configure it however you want. It is great to have a

home network so you can share resources, and it’s usually a lot simpler than your work network.

How do you find these networks? Usually, only one network is found if you're plugged into a wired
network. If you see more than one, it’s either because there are virtual resources setup on the network
or you are connecting into a very advanced network. If you’re trying to connect to a wireless network,
you'll see a lot of wireless networks, because you won’t just see your home network. In either case,
select the network you want to connect to and then put in the password, if required. A password is
usually required for a wireless network, as a lot of times on a wired network, you just hook up to it and
you’re good to go. There are times, though, when a wired network may be set up to require
authentication with a user name and password. Once everything’s detected, you're good to go. Keep in
mind here, that throughout the operating system, there are multiple ways to search for and connect to

a network, especially wireless networks, but I’'m just showing you a single method for simplicity.
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Ethernet

Ethernet

E Ethernet

Connected

Related settings
Change adapter options

Change advanced sharing options
Network and Sharing Center

Windows Firewall

Have a question?
Get help

Make Windows better

Give us feedback

Figure 50: Ethernet adapter status in the Settings app

Navigation Options

Settings App > Network & Internet > Ethernet (Wifi)

Testing the Connection
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The next thing | want you to be able to do is to test your connection. You need to know if the network

you’re connected to is working, and if you can get to the internet and browse network resources, your

connection is working. The way you find out if you’re connected is by checking the network icon in the

notification tray. That’ll give you an indication of whether you’re fully connected or there’s no internet

access or you can’t access network resources. You can see here from this screenshot in the Settings app

(fig. 51), you can check the network status. You can also try browsing to a network resource. To do this,
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go back to the File Explorer or the Network section and see if you can see other network devices or
browse to them. The other way to make sure you can get on the internet is to open up a webpage, like

Google.com. Typically, if you can get to Google.com or another web page, you can get anywhere on the

networks.

= a X
Status
ion?
Network status Have a question?
Get help
g @ Make Windows better
vEthernet (Virtual Network Switch)
Private network Give us feedback

You're connected to the Internet

If you have a limited data plan, you can make this network a
metered connection or change other properties.

Change connection properties

Show available networks
Change your network settings

@ Change adapter options
View network adapters and change connection settings.

% Sharing options

For the networks you connect to, decide what you want to share.

Network troubleshooter
Diagnose and fix network problems.

View your network properties
Windows Firewall
Network and Sharing Center

Network reset

Figure 51: Network status page in the Settings app

Navigation Options

Settings App > Network & Internet > Status

So what about browsing your network? Again, as | mentioned, you can go to the Network section in the
File Explorer. If you know a device’s IP address, you can connect directly to it. Or, as | previously

mentioned, you can open a network browser and pick a website and go to it. If you can’t get to the first
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website, | suggest you try a second website to make sure it’s not an issue with the website you tried to

get to.

Now that you are familiar with connecting to networks, the next thing | want to go over are some

keyboard and system shortcuts that are very useful.

Keyboard & System Shortcuts

Keyboard Shortcuts

Here, | will touch on some common keyboard and system shortcuts. | will also give you links to some
others you might be interested in. You may already know some of these, but these are basic ones

everyone can find useful.
The following are some of the shortcuts you can do using the Control (Ctrl) button:

e Ctrl+C copies any highlighted text or anything you have selected to your clipboard.

e  Ctrl+V pastes the last thing you copied or cut onto the clipboard.

e Ctrl+Z allows you to undo the last change you made in a document.

e  Ctrl+Y allows you to redo a recent undo.

e Ctrl+Enter Typing a website name and using the Ctrl+Enter keyboard shortcut allows you to
quickly go to a website just by typing its name, instead of the whole address with the www. and
.com portion. For example, if you want to go to Google, you don’t have to type
www.google.com; you can just type “Google” and then hit Ctrl+Enter, and that’ll put in the
www. and the .com portion, and boom, you’re at the website. You just want to keep in mind

that this only works with .com, not .net, .edu, etc.

There are also some keyboard shortcuts that work with your desktop and Windows:

e The Windows key opens the Start Menu, if you have that key.
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e  Windows+D minimizes any open windows and shows you your desktop.

e Windows+, allows you to take a peek at the desktop, and then as soon as you release the keys
all your windows that were already open will pop back up.

e  Windows + Left arrow or Windows + Right arrow allows you to move a window to one side or
the other and dock it. You can also use the Windows key and the up arrow key to maximize an
app, or move it into the top corner, if it is docked to one side. If a window is docked to one side,
you can use the down arrow to move it down into the bottom corner, put it back to a previous
position, or even minimize the window.

Another key you can use is F11. This is useful when you’re in an internet browser and you want to read
more on the screen and you don’t want to see all the menu bars or toolbars. Simply hit the F11 key*,
and that’ll take the window into full screen, with less distractions. Now, if you need to see the menu bar
and you want see the full screen, you can just move your mouse to the top. The menu will come down

or you can hit F11 to come out of the full-screen view. That works for a lot of different applications, so

just give it a try.

*If you are on a laptop your function keys may be defaulted to specific functions for your laptop
such as screen brightness or volume. If this is the case you will need to try the laptop’s special
function key, Fn, along with the F11 key.

If you don’t have a Windows key on your keyboard, another good key combo to know is Ctrl+Esc. That'll

bring up the Start menu.

Again, those are just some of the basics, but these are very valuable time savers. | highly suggest you
play around with these, because once you know them, I’'m sure you will find you use them quite a bit.
There is actually a whole slew of other keyboard shortcuts, and I've provided some links to some

resources here in the book for you that you can click on and go to.

https://support.microsoft.com/en-us/help/12445/windows-keyboard-shortcuts
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https://www.cio.com/article/3125513/windows/killer-keyboard-shortcuts-to-help-you-master-

windows.html

https://en.wikipedia.org/wiki/Table of keyboard shortcuts

Now that you know some of the basic keyboard shortcuts, let’s get into the right-click menus, which are

another type of shortcut you can use to navigate Windows.

Right-Click Menus

| have included several screenshots here to show you what you might see when you open right-click
menus (figs. 52-54). Keep in mind, your options may vary a little bit depending on what applications you

have installed, because some applications may add their own options to the right-click menu.

The first screenshot (fig. 52) is for the desktop. That one is going to be fairly similar across all computers.
Now, of course, mine has a video card control panel option because | have a video card. If your machine
doesn’t have that type of video card, then you won’t have that option. Otherwise, what you see on your

computer should be fairly close to what | have in the screenshot.
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View >
Sort by >
Refresh

Paste

Paste shortcut

Undo Move Ctrl+Z

BB NVIDIA Control Panel

New >

1 Display settings
& Personalize

Figure 52: Desktop right-click menu

The next screenshot (fig. 53) shows what happens when you right-click on a folder. These are the
various options you have. This is going to look very similar to the next one, which shows what happens

when you right-click on a file (fig. 54), but yet there are still some differences.
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Open

Print

7-Zip >
CRC SHA >
Edit with Notepad++

o4
e

Move to Dropbox

© &

Scan with Windows Defender...
Share

Open with...

Give access to >

Restore previous versions

Send to >

Cut
Copy

Create shortcut
Delete

Rename

Properties

Figure 53: Folder right-click menu

Figure 54: File right-click menu

| wanted to show you these because they are the three most common right-click menus you will see.

Now, of course, as | mentioned previously in the book, you’ll have some specialized right-click menus,

like you saw earlier when we right-clicked on the start button instead of left-clicking, which brought up

the special right-click menu of the Start menu.

Alternate File Explorer Menus

Also as mentioned earlier, there are some alternate or special menus in the File Explorer. I've got a

couple here to show you (figs. 55-56). The first one, which is a special menu, is the picture tool options

that come up when you have a picture file. This particular example shows the Manage tab. With this
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tool, you can rotate images left or right, put the picture in a slideshow, or make an image your desktop

background.

Picture Tools

View

Home Share

S W,

Rotate Rotate Slide Set as
left right show background

Manage

Rotate View

Figure 55: Picture Tools Manage menu in File Explorer

Now, some special menus, for example, This PC menu, don’t have the standard Home, Share, View

options. This is a special view within This PC that gives you special options or actions you can take.

e B | ™ispC

Computer View

{4’ 4 m Uninstall or change a program
V4= P » @ [

1™ System properties
1 Properties Open Rename  Access Map network Add a network Open =
media~ drive v location Settings fra’ Manage

Location Network System

Figure 56: Computer menu for This PC in File Explorer

Custom Commands

The other special options you have are for some custom commands. The most common are keyboard
macros. I’'m not really going to dive into a whole lot of detail here, because some of these are more
advanced topics, but | want to let you know they exist. If you have a keyboard that is more specialized,
not just basic, it may have programmable keys. For example, my keyboard has programmable keys, and |

have different memory blocks. Each memory block means each key can have a different command
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attached to it. You can get very complex with this or keep it as simple as you like. | have some special
resources here where you can get more information on this if you are interested in reading up further

on it.

https://fieldguide.gizmodo.com/create-your-own-keyboard-shortcuts-to-do-anything-on-wi-

1821529700

https://www.howtogeek.com/290501/how-to-create-custom-keyboard-shortcuts-with-autohotkey/

Now we have covered some simple keyboard and system shortcuts, let’s move on to our final topic:

troubleshooting steps.

Troubleshooting

It is very important to know how to do some basic troubleshooting in Windows, to round out your
fundamental Windows OS skills. The following are some steps you should always take when you have a

problem:

1. Note the steps you took or actions you did to cause the issue. This allows you to give these
steps to someone else to reproduce for troubleshooting if needed. For example, take
screenshots of issues and add comments to the screenshots telling what you did. You can even
use the Steps Recorder. This is a built-in Windows application that captures screenshots and
indicates what commands/actions you performed, for example, if you right-clicked in a menu or

clicked a certain item, etc. This can be very helpful for troubleshooting.

Navigation Options

Search Bar > Type “Steps Recorder” > Click “Steps Recorder”
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2. Capture any error messages. Error messages can really help pinpoint the cause of an issue.
Again, screenshots are also very helpful for any error messages that come up.

3. Reboot the computer first, before troubleshooting further or calling for support. | can
guarantee you, most times, the first thing someone will ask you is, “Have you tried rebooting?”
Here’s why: rebooting will solve nearly half of your problems, and rebooting will also give you a
fresh session. If you reboot and you have a fresh session and you get the issue again, it is a
pretty good indication that there is truly an issue. It could be, for example, that over time you
have used the computer and built up files and used resources, and maybe something is just
getting tied up and causing an error. By rebooting, you are essentially releasing everything and
starting fresh. With the resources freed, the task can now happen as intended and you may no
longer have the problem.

After rebooting, whether you still have the problem or not, repeat the previous steps that
produced the error. Then, if you don’t get the error anymore, you know the reboot fixed the
problem. If you're still getting the same error, make notes and get the info off to whomever can
help you if you can’t fix it. You may also need to capture any new error messages and add those

to the previously captured information, in the case that the reboot causes more errors to pop

up.

Those are the steps you should take to begin troubleshooting issues. Now let’s look at some additional

tools available for troubleshooting and how to use them.

Additional Tools for Troubleshooting

There are several additional tools that are great for troubleshooting, and | want to familiarize you with
them so you can begin to feel comfortable troubleshooting for yourself.

Task Manager

First is the Task Manager. Your view may look different than the screenshot | have included, but when
you open the Task Manager, you will click the little arrow at the bottom that is pointing down, to expand
the Task Manager to the view that | have in the screenshot (fig. 57). The Task Manager allows you to see

if there’s a problem with an app or service or if a certain program is chewing up a lot of system
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resources. For example, you can see in my screenshot that my Google Chrome browser is using quite a
bit of my system memory, as it’s highlighted in an orangish-yellow color. This could potentially indicate a
problem. However, in my case, using a lot of system memory for Google Chrome is expected, since |
have it open a lot and | use it a lot. | also have quite a bit of memory, so | can handle that load. It all
depends on the available system resources you have. Check those resources so you can determine if a

certain task is using them up and causing your computer to perform poorly.

#@4 Task Manager - O X
File Options View
Processes Performance App history Startup Users Details Services
% 12% 69% 0% 0%
Name Status CPU Memory Disk Network
A
Apps (17)
u Adobe Acrobat Reader DC (32 bit) 0% 1.0 MB 0 MB/s 0 Mbps
€ Google Chrome (30) 3.3% 3,2404 MB 0 MB/s 0.1 Mbps
{5+ LTClient (32 bit) 0% 23.0 MB 0 MB/s 0 Mbps
™ Malwarebytes Tray Application (... 0% 3.8 MB 0 MB/s 0 Mbps
[ Microsoft Outlook (32 bit) 0.5% 88.3 MB O0MB/s 0.1 Mbps
m Microsoft PowerPoint (32 bit) 0% 107.3 MB 0MB/s 0 Mbps
Bl Nitro Pro (3) 0% 6.2 MB 0 MB/s 0 Mbps
| Notepad 0% 0.2 MB 0 MB/s 0 Mbps
| Notepad 0% 0.2 MB 0 MB/s 0 Mbps
| Notepad 0% 0.2 MB 0 MB/s 0 Mbps
&8 o-Dir 32bit) 0% 18.5 MB 0 MB/s 0 Mbps
[53 settings 0%  51.1MB 0 MB/s 0 Mbps
2 &% Snippina Tool 07%  140MB 0 MB/s 0 Mbps . ¥
() Fewer details End task

Figure 57: Expanded Task Manager view showing running processes

Navigation Options

1. Right click the Start Button > Task Manager
2. Right click the Task Bar > Task Manager
3. Search Bar > Type “Task Manager” > Click on “Task Manager”
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The Task Manager is a very helpful tool, and people don’t use it enough. | really encourage you to use it
a lot more. Here, we're just looking at the first tab in Task Manager, which is Processes. This shows you
all the running apps and processes if you scroll down in this view. There’s also a Performance tab so you
can see the performance of your CPU, memory, and network usage and get an idea of what’s going on.
You can see app history. You can see what’s running at startup. You can see if there are multiple users
logged in on the system. Maybe, for example, there are too many people logged in and that’s what’s
causing a lot of resources to be used up. Again, | just highly encourage you to familiarize yourself with

the Task Manager and use it.

Windows Troubleshooter

Another tool built into Windows is the Windows Troubleshooter (fig. 58). It can walk you through
troubleshooting an issue. It'll also help fix an issue automatically. If it can’t, it will usually provide
suggestions. The Windows Troubleshooter typically can be accessed via the right-click menu. Most of
the time, if you see a device that has an icon indicating there’s a problem, the troubleshooter is an

option on the right-click menu.
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What type of networking problems are you having?

Are you looking for help with a different issue?

—> I'm trying to reach a specific website or folder on a network

—> I'm having a different problem
Show me other netwoerk troubleshooting options.

Windows tested your Internet connection and verified that you are able to access some websites.

Cancel

Figure 58: Windows network troubleshooter
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Navigation Options

Settings App > Update & Security > Troubleshoot > Select issue type

Microsoft Easy Fix

Another tool that’s great for troubleshooting is Microsoft Easy Fix. These are tools provided by Microsoft

that can be downloaded to fix an issue. These are usually found in Microsoft support articles. | am not

going into detail about these here, but | have included a link to an article about how to use these and

where to find some of these Easy Fix tools.

https://support.microsoft.com/en-us/help/2970908/how-to-use-microsoft-easy-fix-solutions
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Google It

Another troubleshooting resource people don’t always think about is Google. When all else fails,
perform a Google search of the issue, because | can almost guarantee there is someone else out there
who has had the same issue. When performing a Google search, include some of the following

information:

e Any error codes.

e What operating system you’re using (e.g., “I’'m on Windows 10. It’s a home edition, 64-bit.”)
because the issue could be something very specific to that system.

e What program is having the issue.

e Any additional information that can help solve the issue. However | would also caution that you

can sometimes get too specific and might not be able to find what you’re looking for.

Conclusion

Congratulations! You now have the tools you need to master the basics of the Windows operating
system. | hope you found the information | shared very useful and straightforward. Again, this basic

information is meant to get you started so you can build up your fundamental computer skills.

| highly encourage you to review this book multiple times. This information is not something that you’ll
be able to learn and master overnight. It takes repetition and learning and asking questions and looking

at some additional online resources.

If you find that you aren’t sure how to do some things, and it’s okay if you don’t, you can refer back to

this book, use Google, and use the additional resources | included in this book.
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If you want more information or need help with something, I’'m also here to help. Simply contact me

using the information below:

help@restech.solutions

| look forward to hearing from you and wish you much success as you begin to master using your

computer!
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